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Preface

Audience for This Guide

Welcome to Release 11i of the Oracle Universal Work Queue Implementation
Guide.

This guide assumes you have a working knowledge of the following;:
= The principles and customary practices of your business area.
s Oracle Universal Work Queue

If you have never used Oracle Universal Work Queue, Oracle suggests you
attend one or more of the Interaction Center training classes available through
Oracle University.

= The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

This document contains the information you need to understand and use Oracle
Universal Work Queue.

Chapter 1, "Introduction", describes the components of the Interaction Center
product family and the key features of Oracle Universal Work Queue. This chapter
also lists any new or obsolete features in this release.

xi



Chapter 2, "Technology, Requirements, and Performance", describes the technology
stack for Oracle Universal Work Queue and the Oracle Universal Work Queue
architecture. This chapter also lists the minimum hardware and software
configuration for Oracle Universal Work Queue.

Chapter 3, "Dependency Requirements and Verification", describes applications that
are required for Oracle Universal Work Queue to function or that provide
additional functionality.

Chapter 4, "Implementation Overview", describes the implementation process and
lists the implementation steps.

Chapter 5, "Implementation Tasks", provides task-based procedures for
implementing Oracle Universal Work Queue.

Chapter 6, "Verifying the Implementation", provides task-based procedures for
verifying that the implementation of Oracle Universal Work Queue is successful.

Chapter 7, "Diagnostics and Troubleshooting", describes how to troubleshoot the
implementation of Oracle Universal Work Queue.

Chapter 8, "Integrating Oracle Universal Work Queue with Oracle Interaction
Blending", describes how to integrate Oracle Universal Work Queue with Oracle
Interaction Blending.

Chapter 9, "Integrating Oracle Universal Work Queue with Oracle Interaction
Center Intelligence", describes how to integrate Oracle Universal Work Queue with
Oracle Interaction Blending.

Appendix A, "Oracle Universal Work Queue Implementation Worksheets",
provides worksheets for recording implementation decisions.

Appendix B, "Oracle Universal Work Queue Profile Options", lists profile options
for Oracle Universal Work Queue.

Appendix C, "Oracle Universal Work Queue Server Parameters", lists database
server parameters for Oracle Universal Work Queue.

Appendix D, "Oracle Universal Work Queue Command Line Parameters", lists
command line server parameters for Oracle Universal Work Queue.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of

Xii



assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Other Information Sources

You can choose from many sources of information, including online
documentation, training, and support services, to increase your knowledge and
understanding of Oracle Universal Work Queue.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.

Related Documentation

Oracle Universal Work Queue shares business and setup information with other
Oracle Applications products. Therefore, you may want to refer to other product
documentation when you set up and use Oracle Universal Work Queue.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at
http://oraclestore.oracle.com.
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Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Universal Work
Queue (and any other Oracle Applications products). This guide also includes
information on setting user profiles, as well as running and reviewing reports and
concurrent processes.

You can access this user’s guide online by choosing "Getting Started with Oracle
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Universal Work Queue Concepts and Procedures
Use this guide to administer and use Oracle Universal Work Queue.

Oracle Applications Interaction Center Implementation Guide
Use this guide to implement Interaction Center Server Manager.

Oracle Advanced Inbound Implementation Guide
Use this guide to implement inbound media for an interaction center.

Oracle Advanced Outbound Implementation Guide
Use this guide to implement outbound media for an interaction center.

Oracle Scripting Implementation Guide
Use this guide to implement Oracle Scripting.

Oracle eMail Center Implementation Guide
Use this guide to implement Oracle eMail Center.

Oracle Interaction Center Intelligence Implementation Guide
Use this guide to implement Oracle Interaction Center Intelligence.



Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 117, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps

This guide contains specific steps needed to complete installation of a few of the
CRM products. The steps should be done immediately following the tasks given in
the Installing Oracle Applications guide.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release
10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release
11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

XV



XVi

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
e€TRM is available on Metalink

Oracle CRM Application Foundation Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.



Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Universal
Work Queue and reach full productivity quickly. You have a choice of educational
environments. You can attend courses offered by Oracle University at any one of
our many Education Centers, you can arrange for our trainers to teach at your
facility, or you can use Oracle Learning Network (OLN), Oracle University’s online
education utility. In addition, Oracle training professionals can tailor standard
courses or develop custom courses to meet your needs. For example, you may want
to use your organization’s structure, terminology, and data as examples in a
customized training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Universal Work Queue
working for you. This team includes your Technical Representative, Account
Manager, and Oracle’s large staff of consultants and support specialists with
expertise in your business area, managing an Oracle8i server, and your hardware
and software environment.

OracleMetaLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and

Upgrade/ Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.
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Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

xviii

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
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Introduction

Topics include:
s Section 1.1, Oracle Interaction Center Overview
»  Section 1.2, Oracle Universal Work Queue Overview

s Section 1.3, New in this Release

1.1 Oracle Interaction Center Overview

Every customer interaction — a telephone call, an e-mail message, or a Web chat
conversation — presents an opportunity to win new business or improve customer
satisfaction. The Oracle Interaction Center supports the management and
processing of customer relationship activity across all channels of customer contact.

The Oracle Interaction Center integrates with several customer relationship
business applications in the Oracle eBusiness Suite. The Oracle Interaction Center
consists of several modules. The modules relating to inbound telephony and
outbound telephony are bundled separately.

The Oracle Interaction Center allows access to centralized customer information
and business application functionality. Oracle Interaction Center integrates with
front office applications (known as Customer Relationship Management or CRM),
and back office applications (Enterprise Relationship Planning or ERP), thereby
enabling a workflow powered, end-to-end strategic e-business solution.

The Oracle Interaction Center products include:
= Oracle Advanced Inbound
= Oracle Advanced Outbound

s Oracle eMail Center
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= Oracle Scripting

= Oracle Interaction Center Intelligence

See Also
s Section 1.2, Oracle Universal Work Queue Overview

s Section 1.3, New in this Release

1.1.1 Oracle Advanced Inbound

Oracle Advanced Inbound (AlI) is required to telephony enable business
applications in the Oracle eBusiness Suite. "Telephony-enabled" means that the
product has the capability of communicating with a telephone system for inbound
calls, outbound calls, or both via the CTI middleware that handles the messaging
between a telephone switch and the user’s application. Oracle Advanced Outbound
provides the corresponding outbound telephony capability.

The Oracle Advanced Inbound bundle consists of the following products: Call
Center Technology, Oracle Universal Work Queue, Oracle Telephony Manager,
Oracle Call Center Connectors, and Oracle Interaction Blending.

See Also
s Oracle Advanced Outbound

s Oracle eMail Center
= Oracle Scripting

s Oracle Interaction Center Intelligence

1.1.2 Oracle Advanced Outbound

Oracle Advanced Outbound (AO) is another key part of the Oracle eBusiness Suite
of applications. It is the module of Oracle Interaction Center that addresses
outbound telephony. AO consists of two main components:

= A tactical list manager, which determines who to call and when to call them

= Anoutbound dialing engine, which dials numbers and transfers live contacts to
call center agents

Advanced Outbound integrates with and relies on Oracle Marketing Online (OMO)
to create campaigns and lists to execute. AO serves as the execution arm for these
marketing lists to maximize both outbound list penetration and agent productivity.
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AO also integrates with desktop applications like Oracle TeleSales and Oracle
Collections to handle the actual customer interactions. Oracle Advanced Outbound
can be used any time agents need to contact parties via the telephone.

AO also integrates with Oracle Interaction History to provide feedback that
marketers can use to analyze and measure the success of the marketing campaign,
thereby providing a closed-loop marketing process.

Oracle Advanced Outbound does not include any other telephony management
modules, and thus requires the use of Oracle Advanced Inbound.

See Also
s Oracle Advanced Inbound

s Oracle eMail Center
= Oracle Scripting

= Interaction Center Intelligence

1.1.3 Oracle eMail Center

Oracle eMail Center (eMC) is designed to satisfy requirements for inbound
customer support, e-mail interaction management, and outbound sales and
marketing e-mail message processing.

Oracle eMail Center helps your business respond to e-mail queries with clear and
comprehensive replies in a much more efficient manner. eMC automatically
generates suggested responses and scores them according to how closely they
match the requirements.

See Also
s Oracle Advanced Inbound

s Oracle Advanced Outbound
= Oracle Scripting

s Oracle Interaction Center Intelligence

1.1.4 Oracle Scripting

Oracle Scripting is a set of tools to create and display information sequentially to
end users. Oracle Scripting is composed of three components: the Script Author, the
Scripting Engine, and the Survey Component.

Introduction 1-3



Oracle Interaction Center Overview

Oracle Scripting end users include interaction center agents (for the Scripting
Engine), and customers or prospects using a Web browser (using the Survey
component). Other users include individuals who build the scripts (Script Author
users) and administrators of scripting or survey campaigns, who must access the
Survey Admin console.

Using Oracle Scripting, an enterprise gains the ability to develop and deploy
scripted presentations for customer interactions with agents, as well as build,
deploy, and execute information-gathering survey campaigns for data which can be
mined and used to tailor sales and service campaigns or improve customer
satisfaction.

See Also
s Oracle Advanced Inbound

s Oracle Advanced Outbound
s Oracle eMail Center

= Oracle Interaction Center Intelligence

1.1.5 Oracle Interaction Center Intelligence

Oracle Interaction Center Intelligence is a Web-based reporting solution that
provides intelligent reports that facilitate day-to-day operational and long-term
strategic decisions.

The data is presented to the user in a easy-to-use portal format. This format gives
the user a unified, role-based, easily customizable view of Interaction Center
information, including Oracle Universal Work Queue information, key performance
metrics relating to agent productivity, speed to answer, and abandon rate.

The product is built on an Oracle proprietary Java-based technology stack (Oracle
CRM Foundation, also known as JTF).Users of Interaction Center Intelligence
require minimal training, and no additional software is needed on the user’s
machine other than a Web browser.

Oracle Interaction Center Intelligence is based on a three-tier architecture:

s The front end (client) using the system via an Oracle Applications-compliant
Web browser.

= The middle tier, which contains the Apache Web server and application server,
included as part of the installation of Oracle Applications release 11: .

s The database tier, using an Oracle 8i or 9i database.
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See Also
s Oracle Advanced Inbound

s Oracle Advanced Outbound
s Oracle eMail Center
= Oracle Scripting

= Interaction Center Intelligence

1.2 Oracle Universal Work Queue Overview

Oracle Universal Work Queue is an agent portal that presents and delivers work
items generated through customer contact channels or CRM business applications.
Agents can select work directly from the Oracle Universal Work Queue desktop
user interface.

Work which originates from a customer contact channel, such as a telephone call or
an e-mail, is called a media work item. Work which originates from a CRM business
application, such as a task or lead, is called an application work item. You can set
up Oracle Universal Work Queue to handle application work items only, or both
application and media work items.

See Also
s Section 1.1, Oracle Interaction Center Overview

s Section 1.3, New in this Release

1.2.1 Oracle Universal Work Queue Features

Oracle Universal Work Queue:
= Provides a desktop interface that displays a unified view of agent work.
= Facilitates agents interactions across multiple contact channels.

= Provides a framework that enables CRM business applications to integrate with
media work.

= Balances agents between media types based on the service levels for the
interaction center.

By providing a unified view of agent work, Oracle Universal Work Queue
minimizes the complexity of agent interactions across multiple contact channels and
CRM business applications. Oracle Universal Work Queue also provides a standard
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programming interface for CRM business applications and media enablers to
request, receive, and display agent work information.

Agents interact with application and media work through a consistent interface.
Through integration with Oracle Interaction Blending, agents are moved between
media queues based on the service levels for the interaction center.

1.3 New in this Release

1.3.1 Notices

Topics include:

s Section 1.3.1, Notices

s Section 1.3.2, Worklist

= Section 1.3.3, Session History Logging
s Section 1.3.4, icWork Controller

= Section 1.3.5, Enterprise Tasks

s Section 1.3.6, Escalations

= Section 1.3.7, Blending

See Also
s Section 1.1, Oracle Interaction Center Overview

s Section 1.2, Oracle Universal Work Queue Overview

Notices are communications from applications to users. Oracle Universal Work
Queue notices provide the mechanism for near real-time notices to be sent from
applications to the agent. These notices will be displayed in the notice control, an
icWork component. The appearance of notices is subject to integrated applications
support. For example, generating a service request from Oracle TeleService sends a
notice to agents using Oracle Universal Work Queue. For implementations that use
notices, you must enable Oracle Universal Work Queue’s IEU: Message: UL: UWQ
Notices profile option. From the perspective of the application from which notices
originate, other setup steps may apply, as appropriate.
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1.3.2 Worklist

Oracle Universal Work Queue now has queued access to application work through
the Worklist feature. Items being published to the Worklist are dependent on
integrated applications support. Work can be retrieved from the Worklist using:

s The Get Work button in the Universal Work Queue window.
s The Next Work button in the icWork Controller.
To enable the Worklist, set the IEU: Queue: Work List profile option.

1.3.3 Session History Logging

Oracle Universal Work Queue session history logging now records an increased
number of attributes, such as agent phone extension for the session, agent break
reason, etc. To enable session history logging, set the IEU: Session History Logging
profile option.

1.3.4 icWork Controller

The icWork Controller is a floating window which contains the soft phone and
other tabs to provide easy access to Oracle Universal Work Queue functionality.
The icWork controller will be automatically enabled in any one of the following
scenarios:

s Media is used.
= Notices are enabled.
= Session history logging is enabled.

s Worklist is enabled

1.3.5 Enterprise Tasks

This new node, labelled Tasks, contains subnodes which segment tasks by
ownership and assignment type. The previous Tasks nodes are disabled by default.
They are only kept for backward compatibility and are not recommended for use. If
needed, they can be enabled through the profile options. To enable the new Tasks
node, set the IEU: Queue: Enterprise Tasks profile option.
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1.3.6 Escalations

This new node, labelled Escalations, contains subnodes which segment individually
owned escalations by escalation level. To enable the new Escalations node, set the
IEU: Queue: Escalations profile option.

1.3.7 Blending

The IEU: Blending Style profile option now has five prepopulated choices in the
drop down list of values. The old "Forced Blended" value has been renamed "Full
Forced Blended." The "Not Blended" value remains unchanged. The only other
value that has relevance is "Full Optional Blended."

Blending Style Profile Option Description

Full Force Blended When the Full Force Blended profile option is selected, the
only agent media option is "Blended." For this
option, the interaction center Blending Sever must
be fully implemented.

Full Optional Blending When the Full Force Blended profile option is selected,
agents can choose from their assigned media sources
(e.g., Inbound, Outbound, or Web Callback) in
addition to the Blending Node, to support blending.
As with Forced Blended, the interaction center
Blending Sever must be fully implemented and.
When agents select the blended media as their
source, the Blending Sever will determine the
agent’s media source.

Not Blended Select Not Blended if you have not implemented the
interaction center Blending Server, or if agents are
not set up for a level of service work that includes
blended media.

1.4 Obsolete in this Release

Several profile options are obsolete in the latest release of UWQ. For specifics, see
Appendix B.1, Obsolete or Reserved Profile Options.
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2

Technology, Requirements, and
Performance

Topics include:

Section 2.1, Architectural Overview
Section 2.2, Minimum Software Requirements

Section 2.3, Minimum Hardware Requirements

2.1 Architectural Overview

Oracle Universal Work Queue is a work presentation and access framework that
provides "plug-in" interfaces to integrate interaction center media and application
work items with Oracle eBusiness applications. It is built of seven components:

1.

UWQ Server provides a centralized, plug-in infrastructure for integration of
new media providers.

The UWQ Application Interface is a desktop Java bean that channels media
events, information, and control commands between the UWQ server and
eBusiness applications and media controllers such as the soft phone.

The UWQ Form is UWQ’s primary user interface and provides a plug-in
infrastructure for application work item presentation and access.

The Interaction Center Work Controller (icWork Controller) is a Java
component of the application interface that supports plug-in media and work
item controls such as the Oracle soft phone and the Notice control. It also acts as
a second, reduced form-factor, lightweight user interface for work access.
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5. Session information provides enhanced agent productivity for Interaction
Center Intelligence across an agent session. It adds agent full session time (log
in to log out), break times and reasons, media item request, delivery and
completion times, and work item request and delivery times above the
Interaction History times.

6. Notices is a communication component that enables applications to alert agents
to work item life cycle events such as work item creation and assignment,
updates, and status changes. The notices component consists of a PL/SQL API,
database tables, and the Java notice control plug-in to the icWork Controller.

7. Worklistis a PL/SQL API and database component that enables prioritized,
serial, queue-like delivery of work items.

2.1.1 Oracle Universal Work Queue Server

The Oracle UWQ Server provides extensible plug-in integration for media
providers. This allows standardized, more rapid introduction of new media. Media
providers, such as Oracle Telephony Manager, Oracle Advanced Outbound and
Oracle Interaction Blending “plug into” the UWQ Server infrastructure to deliver
media counts and media items to agents and applications through UWQ.

The server provides common functions to all media providers including assigning
agents to the media provider, channeling media items (normalized media events
and information) to applications, and passing control instructions from applications
and media controllers to media providers.

2.1.2 UWQ Application Interface Bean

The Application Interface Bean delivers media events and media information to
interaction center applications and to media controllers. It acts a channel between
the UWQ UI, media controllers, and applications to effect interactions.

The Application Interface Bean passes low-level media events and information from
the media provider, through the UWQ server, to the media controller, such as the
soft phone. For example when an inbound call is received, the media provider
(OTM) sends the inbound call event and call information (such as ANI and DNIS)
to the UWQ server. The UWQ server passes this information to the icWork
Controller soft phone plug-in through the Application Interface Bean.

The Application Interface interacts with the application, passing media events and
facilitating screen pop by giving applications media information in an accessible
format. For example, to effect a screen pop, the Application Interface Bean sends a
call event and name-value pair screen pop information to the appropriate

Technology, Requirements, and Performance 2-3



Architectural Overview

application form. It also passes end interaction events and requests for the next
media item from the application to the UWQ server. The UWQ server then relays
the request to the media provider.

2.1.3 UWQ Interaction Center Work Controller (icWork Controller)

The icWork Controller is a new component in release 11.5.6 that behaves like a
universal remote control for work. It provides a standard format for media
controllers such as the OTM soft phone and for lightweight user features such as the
notice controller. New media and work controls may extend the icWork Controller
through its Java plug-in facilities. The icWork Controller provides standard alerts
when new media or notices are received, and provides a standard set of work access
control icons that allow agents to request the next Worklist item, cancel the current
media request, request a break, or resume with the next call.

2.1.4 Oracle Universal Work Queue User Interface

The UWQ user interface is an Oracle Form that presents a unified view of agent
media sources and work items. From this Form, agents can select a work item for
processing and request the next media item from a media source.

Application work providers plug-in work item nodes, views, and application
launch functions. Agents may order work item summary lines to identify the next
work item, select the work item, and launch the application form. Media providers
channel media sources and counts through the Application Interface from their
UWQ Server media plug-in.

The UWQ user interface also records important session events in the session
information component.

2.1.5 UWQ Session Information

The session information component extends Interaction Center Intelligence with
agent session information. This includes agent session length based on login and
logout time as well as end session reason. It also includes important session events
that reflect agent productivity, including agent break time and reason (from break
start to end break), media item request, delivery and completion times, Worklist
request, delivery and completion times, and work item request and delivery times.
This provides a more complete view of an agent’s work day than can be pieced
together from Interaction History.

2-4 Oracle Universal Work Queue Implementation Guide



Minimum Software Requirements

2.1.6 Worklist

2.1.7 Notices

The new Worklist component provides serial delivery of prioritized work. The
Worklist maintains work state to restrict distribution to one agent at a time. It
aggregates all agent work types into a single set for queue-like next work item
delivery. The application work provider sets work item priorities. The Worklist
consists of database tables that maintain information about all work items accessible
to an agent, and PL/SQL APIs for requesting the next work item, locking the work
item, and setting work item priority.

The Notices component provides applications with communication capabilities to
alert agents of important work item life cycle events such as creation and
assignment of the work item, updates to the work item, and status changes. The
Notice component consists of database tables to store the notices, an API to create
notices, and the Notice Control plug-in to the icWork controller. Applications or
workflows create a notice for a specific agent based on a work item life-cycle event.
The notice is stored in the notice database tables. The notice controller polls the
notice tables and, when it identifies a new notice, alerts agents to receipt of the
notice. The notice controller allows agents to navigate notices, view notices,
acknowledge and clear notices, and to and filter notices based on their state or the
time they when received. An appropriate strategy regarding frequency of polling
must be determined at an enterprise level to ensure agents receive notices on a
timely basis in accordance with existing interaction center requirements.

2.2 Minimum Software Requirements

Oracle Universal Work Queue release 11.5.6 requires, at minimum, Oracle
Applications 11i that was installed from any Oracle Applications 11i Rapid Install
or Platinum and upgraded to release 11.5.6.

Full License Installation Requirements

All UWQ implementations require full license installation. Do not install UNQ with
the "Shared” option. Shared mode, which sets the Install flag at "S" (Shared), is only
used when an unlicensed application provides a key component to a licensed
application. In order for UWQ to function appropriately, the Install flag must be set
to "T" (fully Installed).
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See Also
= Section 3.1, Mandatory Dependencies

= Section 3.2, Conditional Dependencies

2.3 Minimum Hardware Requirements

Oracle Universal Work Queue shares the same requirements for hardware as
indicated by Oracle Applications release 11i. There are no UWQ-specific hardware
requirements.
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Dependency Requirements and Verification

Topics include:
= Section 3.1, Mandatory Dependencies

= Section 3.2, Conditional Dependencies

3.1 Mandatory Dependencies

Implementation Dependencies

From an implementation perspective, mandatory dependencies are applications or
components which must be implemented prior to implementing Oracle Universal
Work Queue, and are required in order for Oracle Universal Work Queue to
function. UWQ has no mandatory implementation dependencies.

Operational Dependencies

Technically, UWQ can be used as a stand-alone application work access tool (for
Oracle Applications users to access tasks or escalations, for example). This requires
no operational dependencies other than Oracle Applications and the relative
Foundation components.

Practically, however, UWQ is typically used as an application work provider (for
business applications such as Oracle TeleSales, Oracle TeleService, or Oracle
Collections), or a media work provider (for applications such as Oracle Telephony
Manager, Oracle Advanced Inbound, Oracle Advanced Outbound, Oracle eMail
Center or Oracle Web Collaboration), or both. Thus, from an operational
perspective, applications used with UWQ can be considered dependencies. These
are addressed in Section 3.2, Conditional Dependencies.
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See Also
Section 3.2, Conditional Dependencies

3.2 Conditional Dependencies

Conditional dependencies provide desired functionality to Oracle Universal Work
Queue but are not required for Oracle Universal Work Queue to function.

Application Work

In order for work items such as tasks and escalations to be useful, you must
implement the following, based on the functionality you require:

Application Work ltem Mandatory Dependency

Tasks Oracle CRM Foundation (Task Manager), Oracle TeleSales,
Oracle TeleService

Escalations Oracle CRM Foundation (Escalation Manager), Oracle TeleSales,
Oracle TeleService

Service Requests Oracle TeleService

Leads Oracle TeleSales

Opportunities Oracle TeleSales

Forecasts Oracle TeleSales

Delinquencies Oracle Collections

Dunning Events Oracle Collections

Broken Promises to Pay ~ Oracle Collections

The above CRM business applications provide application work items which can be
requested through Oracle Universal Work Queue.

Media Work Items

The following media servers provide media work items which can be requested
through Oracle Universal Work Queue:

Media Work Item Conditional Dependency

Inbound Telephony Oracle Advanced Inbound
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Media Work Item Conditional Dependency

Outbound Telephony Oracle Advanced Outbound

See Also
Section 3.1, Mandatory Dependencies
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Implementation Overview

4.1 Process Description

This implementation guide assumes that you have, at a minimum:

Installed Oracle Applications (database, technology stack, and Oracle
Applications files).

See Installing Oracle Applications or Upgrading Oracle Applications.

Installed JInitiator on the agent desktop.

Optionally, implemented Oracle Human Resources Management Systems.
See Implementing Oracle HRMS.

Implemented CRM Foundation Resource Manager.

See Oracle CRM Foundation Implementation Guide.

Implemented at least one CRM business application such as Oracle TeleSales,
Oracle TeleService or Oracle Collections.

See Oracle TeleSales Implementation Guide, Oracle Support Implementation Guide, or
Oracle Collections Implementation Guide, respectively.

If implementing Oracle Universal Work Queue for media work, installed and
configured Oracle Call Center Connectors, if needed, and Interaction Center
Server Manager.

See Oracle Call Center Connectors Implementation Guide and Oracle Applications
Interaction Center Implementation Guide.

See Also
Section 4.2, Implementation Task Sequence
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4.2 Implementation Task Sequence

High Level Implementation Steps

The following list is a high-level overview of the steps required to implement
Oracle Universal Work Queue:

1.

Perform implementation steps required for all interaction center
implementations.

This includes the creation and administration of user accounts in Oracle
Applications and Oracle Human Resources Management System (HRMS) and
subsequent CRM application-specific steps. The steps are listed below and are
described in detail in the Oracle Applications Interaction Center Implementation
Guide.

Perform configuration steps for application work and media work, if
applicable.

These steps are listed below by type of work to be used with UWQ. Any steps
not covered in the Oracle Applications Interaction Center Implementation Guide are
included in this document.

Perform steps to support implementation verification without requiring a
switch.

This includes administration of the Web Phone and starting of the interaction
center servers. The steps are listed below and are described in detail in the
Oracle Applications Interaction Center Implementation Guide.

Required for All Implementations

Perform these tasks to define and configure users for all interaction center
implementations. The tasks listed in this section are described in detail in the Oracle
Applications Interaction Center Implementation Guide.

1.

2
3.
4

Define Oracle Applications users.
Create employees in the enterprise.
Create a CRM resource.

Associate employees in the enterprise database with Oracle Applications user
accounts.

From an Oracle Applications perspective, you must define users that can log into an
Oracle Applications session, and assign each user with the appropriate
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responsibility or responsibilities to perform a particular set of functions. At
minimum, for each implementation, you will need to define (a) an administrator,
and (b) an interaction center agent who is an employee in the enterprise.

An administrator must have access to functions that the typical interaction center
agent will not, and administers users and applications across the broad spectrum.
For example, one function of an administrator is to create agent users. This
necessitates the creation of an administrative user as the first step.

The order in which agent users are created is at your discretion. You may choose to
create Oracle Applications users for each agent immediately following the creation
of an administrative user, assuming you have all information required.
Alternatively, agent users can be created immediately prior to use of an agent logins
required to perform steps for administration or testing.

Oracle TeleSales agents must have roles established that associate them with
particular groups

See Also
s The steps for creating a user in Oracle Applications are detailed in the Oracle
Applications Interaction Center Implementation Guide.

= For a list of responsibilities required for administrators, see Section 5.1.1,
Defining an Administrator for Oracle Universal Work Queue.

= For a list of responsibilities required for agent users, see Section 5.1.2, Defining
an Interaction Center Agent.

Configure for Application and Media Work

Based on enterprise requirements, perform implementation steps required for using
UWQ with Oracle interaction center applications. This typically includes specific
implementation configurations for application work and specific implementation
configurations for media work. For more information, see the discussion in Section
3, Dependency Requirements and Verification.

Required for Application Work

Perform these tasks for implementations requiring the use of UWQ for application
work:

= Configuring Profile Options for Application Work

Required for Media Work
Perform these tasks for implementations requiring the use of UWQ for media work:
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-

Configuring Profile Options for Media Work

Configuring Roles and Usage for an Interaction Center Agent
Creating a Single-Site Interaction Center

Creating a Middleware Configuration

Configuring the Interaction Center Server Process Parameters
Creating Teleset Configurations

Configuring a Media Screen Pop for Oracle Universal Work Queue

©® N o a > @ D

Configuring Interaction Center Parameters for a CRM Resource

Steps to Assist in Implementation Verification
1. Creating Web Phone User Account

2. Configuring the Web Phone Profile Options for the Web Phone User
3. Starting the Interaction Center Servers

For specific descriptions of these tasks, refer to the Oracle Applications Interaction
Center Implementation Guide.

See Also
Section 4.1, Process Description
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Implementation Tasks

This section includes specific tasks to implement Oracle Universal Work Queue.
Some of the steps listed in this section are described elsewhere, but are listed here to
provide context to the series of processes required to accomplish a particular
implementation task.

Topics include:

= Section 5.1, Creating an Agent

= Section 5.2, Implementing Oracle Universal Work Queue for Application Work
= Section 5.3, Implementing Oracle Universal Work Queue for Media Work

5.1 Creating an Agent

As outlined in implementation steps required for all interaction center
implementations, user definition and administration is required to perform an
implementation of UWQ. The following table lists these steps. For specific
descriptions of these implementation tasks, refer to the Oracle Applications
Interaction Center Implementation Guide.

Number

Required? Description Responsibility

d  Stepl

Required Define an Oracle Applications administrator. System Administrator

See Section 5.1.1, Defining an Administrator for
Oracle Universal Work Queue.
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Number Required?

Description

Responsibility

d Step2 Required

Create an employee in the enterprise Oracle database.

This step is performed in Oracle Human Resource
Management Systems (HRMS), if installed. Otherwise,
use CRM Resource Manager.

This can be done before or after creating an Oracle
Applications user account for the employee.

Refer to the Oracle Applications Interaction Center
Implementation Guide.

HRMS Manager for
Oracle Human Resource
Management Systems

OR

CRM Resource Manager
for CRM Resource
Manager

d  Step3 Required

Create an Oracle Applications user account for the
employee.

See Section 5.1.2, Defining an Interaction Center Agent

This can be done before or after creating the employee in
the enterprise Oracle database. This step associates the
employee with an Oracle Applications account.

System Administration

d Step4 Required

Import a CRM resource for the employee.

In order to access CRM applications, you must import an
employee from the enterprise Oracle database using
CRM Resource Manager. This creates a CRM Resource
ID used my most CRM applications.

Refer to the Oracle Applications Interaction Center
Implementation Guide.

CRM Resource Manager

d Step5 Required

Configure resource roles and group roles and usage for
interaction center agents and Oracle TeleSales Users.

For all interaction center agents, additional steps are
required to establish resource roles and group attributes.
Additional properties are required for TeleSales agents.

Refer to the Oracle Applications Interaction Center
Implementation Guide.

CRM Resource Manager

Topics include:

= Section 5.1.1, Defining an Administrator for Oracle Universal Work Queue

= Section 5.1.2, Defining an Interaction Center Agent

See Also
= Section 5.2, Implementing Oracle Universal Work Queue for Application Work

= Section 5.3, Implementing Oracle Universal Work Queue for Media Work
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5.1.1 Defining an Administrator for Oracle Universal Work Queue

In order to implement Universal Work Queue, you must have an administrator
with the following responsibilities. For detailed steps on defining an Oracle
Applications user, refer to the Oracle Applications Interaction Center Implementation
Guide.

Application Work

If you are administering Oracle Universal Work Queue for application work, then
add the following responsibilities:

Responsibility Function Type
System Administrator Create user accounts. Self-Service
HRMS Manager, for example US HRMS  Create an employee. Self-Service

Manager (if Oracle Human Resources
Management Systems is installed)

CRM Resource Manager Create a CRM resource. Self-Service

CRM Task Manager Create tasks to test application work in Oracle Self-Service
Universal Work Queue.

Media Work

If you are administering Oracle Universal Work Queue for media work, then also
add the following responsibility:

Responsibility Function Type

Call Center HTML Administration Administer an interaction center. HTML

See Also
= Section 5.1.2, Defining an Interaction Center Agent

5.1.2 Defining an Interaction Center Agent

In order to verify an Universal Work Queue implementation or use UWQ, you must
have an Oracle Applications user (typically identified with an employee in the
enterprise Oracle database) with the following responsibilities. For detailed steps on
defining an Oracle Applications user, refer to the Oracle Applications Interaction
Center Implementation Guide.
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Responsibility Function Type

Customer Support Access Oracle TeleService functions. Self-Service
TeleSales Agent Access Oracle TeleSales functions. Self-Service
Preferences Access personal profile options. Self-Service

See Also
= Section 5.1.1, Defining an Administrator for Oracle Universal Work Queue

5.2 Implementing Oracle Universal Work Queue for Application Work

If you have defined an administrator for Oracle Universal Work Queue application
work as described in Section 5.1.1, Defining an Administrator for Oracle Universal
Work Queue, then that user has all of the responsibilities necessary to implement
Oracle Universal Work Queue.

Perform the tasks listed in the following table to implement Oracle Universal Work
Queue for application work. Some of the tasks listed in the table below are
described in the Oracle Applications Interaction Center Implementation Guide.
Information specific to UWQ is included in this section. The comprehensive list in
this table is intended to provide context to the series of processes required to
accomplish particular implementation goals.

Number Required? Description Responsibility

d Step1l Required Configure system profile options for application work  System Administrator

in Oracle Universal Work Queue.

See Section 5.2.1, Configuring Profile Options for
Application Work

See Also
= Section 5.1.1, Defining an Administrator for Oracle Universal Work Queue

= Section 5.3, Implementing Oracle Universal Work Queue for Media Work

5.2.1 Configuring Profile Options for Application Work

In order to implement Universal Work Queue to use with application work, you
must configure system profile options accordingly. For detailed steps on
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configuring profile options, refer to the Oracle Applications Interaction Center

Implementation Guide.

The following table lists the Oracle Universal Work Queue profile option values to
be used for testing Oracle Universal Work Queue with application work.

Note: If an IEU profile option is not listed below, then it is either
intended for use solely by Oracle Support Services, reserved for
future use, or obsolete. The value of any unlisted IEU profile option
should be No or null. For a list of profile options, see Appendix B,
"Oracle Universal Work Queue Profile Options".

Profile Option Value
IEU: Blending Style Not Blended
IEU: Desktop: Network: Proxy Port Null
IEU: Desktop: Network: Proxy Server Null
IEU: Desktop: Network: Use Proxy No
IEU: Desktop: Trace Level None
IEU: Desktop: UI: Refresh Style Manual
IEU: Desktop: UI: Show All Nodes Yes
IEU: Message: UI: Refresh Rate Null
IEU: Message: UL: UWQ Notices No
IEU: Optional: Phone Extension Null
IEU: Queue Order: Advanced Outbound Telephony ~ Null
IEU: Queue Order: Blended Null
IEU: Queue Order: Enterprise Tasks Null
IEU: Queue Order: Escalations Null
IEU: Queue Order: Forecasts Null
IEU: Queue Order: Inbound Email Null
IEU: Queue Order: Inbound Telephony Null
IEU: Queue Order: Leads Null
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Profile Option Value
IEU: Queue Order: Media Nodes Null
IEU: Queue Order: Opportunities Null
IEU: Queue Order: Outbound Telephony Null
IEU: Queue Order: Service Requests Null
IEU: Queue Order: Work List Null
IEU: Queue: Advanced Outbound Telephony No
IEU: Queue: Enterprise Tasks Yes
IEU: Queue: Escalations Yes
IEU: Queue: Forecasts Yes
IEU: Queue: Inbound Email No
IEU: Queue: Inbound Telephony No
IEU: Queue: Leads Yes
IEU: Queue: Opportunities Yes
IEU: Queue: Outbound Telephony No
IEU: Queue: Service Requests Yes
IEU: Queue: Work List No
IEU: Session History Logging No

5.3 Implementing Oracle Universal Work Queue for Media Work

If you have defined an administrator for Oracle Universal Work Queue application
work as described in Section 5.1.1, Defining an Administrator for Oracle Universal
Work Queue, then that user has all of the responsibilities necessary to implement
Oracle Universal Work Queue.

Perform the tasks listed in the following table to implement Oracle Universal Work
Queue for media work. Most of the tasks listed in the table below are described in
the Oracle Applications Interaction Center Implementation Guide. The remaining tasks
are included in this section. The comprehensive list in this table is intended to
provide context to the series of processes required to accomplish particular
implementation goals.
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Number Required? Description Responsibility

1 Stepl Required Install and implement Oracle Call Center Connectors. Not Applicable

d Step2 Required  Create a server group. Call Center HTML
See the Oracle Applications Interaction Center Administration
Implementation Guide for steps to create a single-site
interaction center server group. The same principles
apply to a multi-site group.

d Step3 Required  Create a middleware configuration. Call Center HTML
See the Oracle Applications Interaction Center Administration
Implementation Guide for steps to create a middleware
configuration that can be used with the Nortel Meridian
switch simulator, so that you can verify interaction
center application configuration without concern for
switch-specific functionality.

1 Step4 Required  Configure the parameters for the interaction center Call Center HTML
servers. Administration
See the Oracle Applications Interaction Center
Implementation Guide.

d Step5 Required Create teleset configurations. Call Center HTML
See the Oracle Advanced Inbound Implementation Guide for Administration
details on how to enable teleset configurations for use
with verifying interaction center implementations
without regard to switch hardware issues or
configuration.

d Step6 Required  Configure Oracle Universal Work Queue to producea  Call Center HTML
application screen pop for media work. Administration
See Section 5.3.1, Configuring a Media Screen Pop for
Oracle Universal Work Queue

0 Step7 Optional Create a Web phone use for simulating a customer call CCT_WEBPHONE_

to the switch simulator.

See the Oracle Applications Interaction Center
Implementation Guide for details on creating a Web phone
user account, required for verifying the implementation
with the Web phone.

DEMO_RESP
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Number Required? Description Responsibility
d  Step8 Optional Configure the system profile options for the Web System Administrator
phone.

See the Oracle Applications Interaction Center
Implementation Guide for details on establishing the
appropriate system profile options for the Web phone,
required for verifying the implementation with the Web
phone.

d Step9 Required Configure the interaction center parameters for the CRM Resource Manager
CRM resource.

See the Oracle Applications Interaction Center
Implementation Guide for details on configuring the
interaction center parameters for a CRM resource.

d  Step 10 Required  Configure resource roles and group roles and usage for CRM Resource Manager
interaction center agents and Oracle TeleSales Users.

For all interaction center agents using UWQ for media,
additional steps are required to establish resource roles
and group attributes. Additional properties are required
specifically for TeleSales agents.

Refer to the Oracle Applications Interaction Center
Implementation Guide.

d  Step 11 Required Configure the system profile options for media workin System Administrator
Oracle Universal Work Queue.

See Section 5.3.2, Configuring Profile Options for Media
Work.

d  Step 12 Required  Start the servers in the interaction center server group. Call Center HTML

See the Oracle Applications Interaction Center Administration

Implementation Guide for details on starting the
Interaction Center servers.

Topics include:

= Section 5.3.1, Configuring a Media Screen Pop for Oracle Universal Work
Queue

= Section 5.3.2, Configuring Profile Options for Media Work

See Also
= Section 5.1.1, Defining an Administrator for Oracle Universal Work Queue

= Section 5.2, Implementing Oracle Universal Work Queue for Application Work
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5.3.1 Configuring a Media Screen Pop for Oracle Universal Work Queue

Classifications (for example, "Gold Support") can be assigned to calls based on the
information in the call (for example, the number dialed by the caller). Then, for a
specific type of media, the classification is mapped to an application window. When
an agent requests delivery of that media type, the mapped business application is
launched.

Use this procedure to associate media work with a CRM business application.
When a media item is delivered to the Oracle Universal Work Queue desktop, a
CRM business application is launched based on the media type and the media item
classification.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
None

Steps
1. Select the Media Actions tab.

The Media Classification Action Association page appears.
2. In the Media Type field, select Inbound Telephony.
3. Leave the Classification field blank.

Note: The call classification triggers the media action (screen pop).
A blank field in the Classification column is used to indicate the
default media action for an unclassified media item.

4. In the Media Action field, select the Customer Care media function or
TeleSales Inbound Telephony function.

This determines the application that will be launched when a media item of the
specified type with the specified classification is selected from a work node.
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5. To clear a row, select the Remove checkbox to the left of the media classification
action association. Selected rows will be removed when you click Update.

6. To save your work, click Update.
The Media Classification Action Association page appears.

7. To delete a media classification action association, select the Remove checkbox
to the left of the media type and click Update.

See Also
= Section 5.3.2, Configuring Profile Options for Media Work

5.3.2 Configuring Profile Options for Media Work

Use this procedure to set system profile options.

Login
Self Service Login URL

Responsibility
System Administrator

Prerequisites
»  Review Oracle Applications Systems Administrator’s Guide.

= Review Appendix B, "Oracle Universal Work Queue Profile Options".

Steps

1. In the Navigator window, on the Functions tab, choose Profile > System.

The Find System Profile Values window appears. The Site and Profiles with No
Values checkboxes are selected by default.

2. Specify the level or levels at which you wish to view or set profile option
values.

= If you want to view or set profile options for all users at the installation site,
select the Site box.

» If you want to view or set profile options for users working under
responsibilities owned by a specific application, select the Application box
and then select an application from the Application list.
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= If you want to view or set profile options for users working under a specific
responsibility, select the Responsibility box and then select a responsibility
from the Responsibility list.

= If you want to view or set profile options for a specific user, select the User
box and then select a username from the User list.

If you want to display profile options both with and without values, select the
Profiles with No Values checkbox.

If you want to display profile options that include a specific character string,
enter the string in the Profile field.

You may search for profile options using character strings and the wildcard
symbol (%). For example, to find profile options prefixed by "IEU", the product
code for Oracle Universal Work Queue, enter IEU%.

Click Find.
The System Profile Values window appears.
Set the values for the profile options at one or more levels.

When a profile option may be set at more than one level, the value entered at
the Site level has the lowest priority. The value entered at the Site level is
superseded by any value entered at the Application level value and the value
entered at the Application level is superseded by any value entered at the
Responsibility level. The value entered at the User level has the highest priority
and overrides values entered at any other level.

The following table lists the Oracle Universal Work Queue profile option values
to be used for testing Oracle Universal Work Queue with media work.

Profile Option Value

IEU: Blending Style Not Blended
IEU: Desktop: Network: Proxy Port Null

IEU: Desktop: Network: Proxy Server Null

IEU: Desktop: Network: Use Proxy No

IEU: Desktop: Trace Level None

IEU: Desktop: UI: Refresh Style Automatic
IEU: Desktop: UI: Show All Nodes Yes

IEU: Desktop: UI: Refresh Rate Null
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Profile Option Value
IEU: Message: UI: UWQ Notice No
IEU: Optional: Phone Extension Null
IEU: Queue Order: Advanced Outbound Null
Telephony

IEU: Queue Order: Blended Null
IEU: Queue Order: Enterprise Tasks Null
IEU: Queue Order: Escalations Null
IEU: Queue Order: Forecasts Null
IEU: Queue Order: Inbound Email Null
IEU: Queue Order: Inbound Telephony Null
IEU: Queue Order: Leads Null
IEU: Queue Order: Media Nodes Null
IEU: Queue Order: Opportunities Null
IEU: Queue Order: Outbound Telephony  Null
IEU: Queue Order: Service Requests Null
IEU: Queue Order: Work List Null
IEU: Queue: Advanced Outbound Null
Telephony

IEU: Queue Enterprise Tasks Yes
IEU: Queue: Escalations Yes
IEU: Queue: Forecasts Yes
IEU: Queue: Inbound Email No
IEU: Queue: Inbound Telephony Yes
IEU: Queue: Leads Yes
IEU: Queue: Opportunities Yes
IEU: Queue: Outbound Telephony No
IEU: Queue: Service Requests Yes
IEU: Queue: Work List Yes
IEU: Session History Logging No
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7. From the File menu, choose Save.

Your changes take effect as soon as users sign on or change responsibility.

See Also
= Section 5.3.1, Configuring a Media Screen Pop for Oracle Universal Work
Queue
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Verifying the Implementation

Topics include:

= Section 6.1, Oracle Universal Work Queue Implementation Verification Tasks
= Section 6.2, Testing Application Work in Oracle Universal Work Queue

= Section 6.3, Testing Media Work in Oracle Universal Work Queue

6.1 Oracle Universal Work Queue Implementation Verification Tasks

Test your implementation of Oracle Universal Work Queue with application and
media work.

Topics include:
= Section 6.2, Testing Application Work in Oracle Universal Work Queue
= Section 6.3, Testing Media Work in Oracle Universal Work Queue

6.2 Testing Application Work in Oracle Universal Work Queue

This section contains topics that allow you to test the implementation of Oracle
Universal Work Queue for application work.

Topics include:
= Section 6.2.1, Creating a Task

= Section 6.2.2, Opening a Task from Oracle Universal Work Queue

See Also
= Section 6.3, Testing Media Work in Oracle Universal Work Queue
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6.2.1 Creating a Task

Use this procedure to create a task for an Oracle Applications user.

Login

Self Service Login URL

Responsibility
CRM Task Manager

Prerequisites
s Review Oracle CRM Foundation Concepts and Procedures.

Steps

1. In the Navigator window, on the Functions tab, choose Tasks > Tasks.

The

Find Tasks window appears.

2. Click New.

The

Tasks window appears. By default the status is Open and the source

document is Task Manager.

3. Enter the information for the new task.

The

following fields are required:

In the Name field, enter the name of the task.

In the Type field, select a task type.

In the Status field, select the task status

In the Owner Type field, select Employee Resource.
In the Owner, enter the employee name.

In the Priority field, select the task priority.

4. From the File menu, choose Save.

The

task number and source value are automatically generated. You may close

the Task window.

See Also
= Section 6.2.2, Opening a Task from Oracle Universal Work Queue
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6.2.2 Opening a Task from Oracle Universal Work Queue

Use this procedure to verify your implementation of Oracle Universal Work Queue
for application work.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
= Create a task (see Section 6.2.1, Creating a Task).

Steps

1. Navigate to the Universal Work Queue window.

Responsibility Procedure

Customer Support = In the Navigator window, on the Functions tab, choose
Universal Work Queue.

TeleSales Agent 1. In the Navigator window, on the Functions tab, choose
eBusiness Center.

2. From the Tools menu, choose Universal Work Queue.

= If you are enabled for application work only, then the Universal Work Queue
window appears. Please be patient.

If the following profile options are set to Yes, then the icWork Controller

appears:

= IEU: Session History Logging. Enables the Break button in the icWork
Controller.

s IEU: Queue: Work List. Enables the Next Work button in the icWork
Controller.

s IEU: Message: UL: UWQ Notices. Enables the Notices tab in the icWork
Controller.

= IEU: Queue: Inbound Telephony or IEU: Queue: Outbound Telephony.
Enables the Phone tab in the icWork Controller.
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The icWork Controller is a "floating" window. You can move the icWork
Controller window anywhere on your desktop — even outside the Oracle
Applications window.

For information about using the icWork Controller, review Oracle Universal Work
Queue Concepts and Procedures.

2. To manually refresh work counts in the Universal Work Queue window, from
the Tools menu, choose Refresh.

The left pane of the Oracle Universal Work Queue window lists the available
work nodes and the count, or number, of work items in each node.

3. Ifnecessary, expand the Tasks node, then expand My Owned.
4. Click a task type.
The right pane displays a summary of the work items by task type.
5. To work on the item, click the item in the right pane and then click Get Work.
The Tasks window appears with the details of the work item.
6. In the Status field, choose Close.
7. From the File menu, choose Save.
You may close the Tasks window.
8. From the Tools menu, choose Refresh.
Verify that the task count has decreased.
9. To close the Universal Work Queue or Oracle Applications window:

= If session history logging is not enabled, choose File > Close Form or File >
Exit Oracle Applications.

= If session history logging is enabled, choose File > Close Form or File > Exit
Oracle Applications. If exiting Oracle Applications, click OK. The Break
Reason window appears. Select a reason and then click OK.

See Also
= Section 6.2.1, Creating a Task
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6.3 Testing Media Work in Oracle Universal Work Queue

This section contains reference to tasks that allow you to test that implementation
steps to implement media work from UWQ were successful. In order to test media
work in UWQ), perform the following:

s  Simulate an Inbound Call to the Interaction Center
s Handle an Inbound Call in Oracle Universal Work Queue

Since these steps are common to implementation of products other than UWQ), the
detailed descriptions are included in the Oracle Applications Interaction Center
Implementation Guide.

See Also
= Section 6.1, Oracle Universal Work Queue Implementation Verification Tasks

= Section 6.2, Testing Application Work in Oracle Universal Work Queue

Verifying the Implementation 6-5



Testing Media Work in Oracle Universal Work Queue

6-6 Oracle Universal Work Queue Implementation Guide



7

Diagnostics and Troubleshooting

7.1 Common Implementation Errors
Topics include:
= Section 7.1.1, Signing On to Oracle Applications

= Section 7.1.2, Launching the Oracle Universal Work Queue desktop from the
Navigator

= Section 7.1.3, Viewing Work Items
= Section 7.1.4, Accessing Work Items

See Also
= Section 7.2, Log Files and Error Messages

= Section 7.3, UWQ Diagnostic Form

7.1.1 Signing On to Oracle Applications

User can not sign on to Oracle Applications
Indication: User can not log into Oracle Applications.

Problem: Database is down.

Solution: Contact the system DBA to ensure that the database is restarted.

No valid responsibility is available

Indication: The user attempts to log in to Oracle Applications and an error message
displays which indicates that no valid responsibility is available. Or, the user is able
to Log on to UWQ but receives an error message when trying to access a particular
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work item. Note: This problem can occur because you intentionally set the user
profiles so that they could not access certain types of tasks.

Problem: User profile/responsibilities are incorrectly set.

Solution: The HRMS employee must be assigned as a resource for your business.
The user must have responsibility to access all the forms that UWQ will open, or
Forms will not allow the application to open.

7.1.2 Launching the Oracle Universal Work Queue desktop from the Navigator

Agent Resource ID not found

Indication: The user logs in to Oracle Applications and selects to work with UWQ,
an error message displays which indicates that the Resource ID for the agent could
not be found.

Problem: The employee has not been defined as a CRM resource.

Solution: Ensure that the UWQ user has been correctly set up in Oracle HRMS and
in Resource Manager.

Oracle Universal Work Queue desktop does not display

Indication: The user logs in to Oracle Applications and selects the Get Work button,
the business application GUI or the UWQ GUI does not launch.

Problem: Oracle business applications GUI or UWQ GUI is not displayed.

Solution: Test to see if the business application can launch or if the problem lies with
the launching of UWQ. Follow the related debugging steps in the section of this
lesson on diagnostic tools for troubleshooting.

Takes too long to launch the Oracle Universal Work Queue desktop
Indication: Your UWQ users experience a delay time before the Universal Work
Queue window completely displays with entries in the Queue and Count columns.
Problem: Takes too long to log on to UWQ.

Solution: When using the "Login Only" value for the User Profile Option of IEU:
Desktop: UL Refresh Style, UWQ performs a count refresh the when the user first
logs on to UWQ), the refresh operation takes some time. Ensure that you are using
the appropriate refresh strategy for your business.
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7.1.3 Viewing Work ltems

No work items displayed in Oracle Universal Work Queue work item summary
area

Indication: When user selects a work type by selecting a node in the work selector
area, no work item summary lines appear in the work item summary area.
Problem: Work items fail to reach UWQ.

Solution: Ensure that work items are open and are assigned to the user. Also ensure
that the user has performed a manual refresh of work items.

Missing source document

Indication: The user selects to view a Task work item in UWQ, and receives a
missing source document error message.

Problem: Missing source document when accessing tasks.

Solution: This is almost always a problem with the "creation point" for the
document, the business application that was used to create the source document
such as a service request created from Oracle TeleService.

Work items displayed twice in the work item summary area

Indication: When user selects a work type by selecting a node in the work selector
area in the Queue column, double work items display in the work item summary
area. Note: UWQ displays work items for tasks that are owned or assigned to a user.

Problem: User sees double work item entries.

Solution: This can occur when a task is both owned and assigned to the same user.
This frequently occurs when a task is owned by a particular user and is assigned to
be work by a group or users, of which the particular user is a member.

Count values not displayed or refreshed

Indication: The user logs on to UWQ and does not see count values displayed in the
Count column. Or, the user has completed processing work items and the Count
column does not reflect new count values.

Problem: Count values do not display in the Count column or counts do not update
once work items are processed.

Solution: Ensure that you are using the appropriate refresh strategy for your
business operations and that your users are aware of the procedures that they must
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follow to refresh their work item counts, if you are not using an "automatic" refresh
strategy.

7.1.4 Accessing Work ltems

No valid responsibility is available

Indication: The user attempts to log in to Oracle Applications and an error message
displays which indicates that no valid responsibility is available. Or, the user is able
to Log on to UWQ but receives an error message when trying to access a particular
work item. Note: This problem can occur because you intentionally set the user
profiles so that they could not access certain types of tasks.

Problem: User profile/responsibilities are incorrectly set.

Solution: The HRMS employee must be assigned as a resource for your business.
The user must have responsibility to access all the forms that UWQ will open, or
Forms will not allow the application to open.

Oracle Universal Work Queue desktop cannot "Get Work"

Indication: The user can view a Task work item in UWQ, but receives the message
that he cannot do "Get Work" for the open Task work item.

Problem: User can not do "Get Work" for an open task work item.

Solution: Tasks is a multi-object schema which can store tasks and other objects like
Service Requests and so on. From the Tasks detailed panel, click Details to display
the Task Manager screen. Then ensure that there is a valid value in the Source
Document field and the Source Number field. Note: When no valid source
document is referenced, the Task Manager screen will display by default.

7.2 Log Files and Error Messages

Oracle Universal Work Queue server trace function outputs detailed information

about server activity to a console window or a file. By default, the trace function is
off.

To turn on the trace function, set the appropriate Oracle Universal Work Queue
server database parameters. Optionally, when you start the Oracle Universal Work
Queue server, use the appropriate command line parameters. The database
parameter overrides the command line parameter.
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The following command line options set the trace level for the Oracle Universal
Work Queue server.

Trace Level Description

trace_level_error Server errors.

trace_level_warn Server warnings and errors.
trace_level_info Server events, warning, and errors.
trace_level_debug All server activity.

The Oracle Universal Work Queue server does not support enabling or changing
trace levels at runtime. You must stop and restart the server for changes take place.

See Also
= Section 7.1, Common Implementation Errors

»  Section 7.3, UWQ Diagnostic Form

7.3 UWQ Diagnostic Form

Universal Work Queue has a diagnostic form that can be used to get a screen pop
without any full business applications (TeleSales, TeleService, Collections, etc.)
having been implemented. To use the diagnostic form, associate the media action
"Universal Work Queue Media Diagnostics function" with a media type on the
UWQ Media Action screen.

Once this is configured, a media "Get Work" request from the UWQ selector form
will cause the UWQ diagnostic form to pop. The "Universal Work Queue Selector"
responsibility is typically used when testing with the UWQ diagnostic form.

See Also
= Section 7.1, Common Implementation Errors

= Section 7.2, Log Files and Error Messages
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Integrating Oracle Universal Work Queue
with Oracle Interaction Blending

Note: This procedure applies to media work only. This procedure
is only required when implementing Oracle Interaction Blending.

Oracle Interaction Blending must be installed and configured. Oracle Interaction
Blending dynamically moves agents between queues and media types based on the
service levels for the interaction center. For information about implementing Oracle
Interaction Blending, see Oracle Interaction Blending Implementation Guide.

To enable media work blending for Oracle Universal Work Queue, set the Blending
Style profile option to Full Forced Blended. When media work blending is enabled
for Oracle Universal Work Queue, the Media node is replaced with a Blended node.
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Integrating Oracle Universal Work Queue
with Oracle Interaction Center Intelligence

Note: This procedure applies to media work only. This procedure
is only required when implementing Oracle Interaction Center
Intelligence.

To record Oracle Universal Work Queue data for Oracle Interaction Center
Intelligence, set the Oracle Universal Work Queue server database parameter
ENABLE_SESSION_HISTORY to TRUE. The default is FALSE.

Optionally, when you start the Oracle Universal Work Queue serer, use the enable_
session_history command line parameter turn on data recording. The database
parameter overrides the command line parameter.

The Oracle Universal Work Queue server records the following information in the
database:

= Agentlogin

= Agentlogout

= Media item requests
=  Media item deliveries

The additional server activity can affect the performance of the Oracle Universal
Work Queue server.

Oracle Interaction Center Intelligence must be installed and configured. For
information about implementing Oracle Interaction Center Intelligence, see Oracle
Interaction Center Intelligence Implementation Guide.
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Oracle Universal Work Queue
Implementation Worksheets

This appendix includes worksheets that you can use to identify information

required for your implementation. Some information required for implementation

and configuration steps may not be identified in these worksheets.

Complete each worksheet in advance of your implementation to reduce

interruptions in establishing the appropriate implementation and configuration

requirements.

Topics include:

s Section A.1, Oracle Universal Work Queue Administrator Worksheet
= Section A.2, Employee Worksheet

= Section A.3, Employee User Account Worksheet

= Section A .4, Oracle Universal Work Queue Profile Options Worksheet
s Section A.5, CRM Resource Worksheet

= Section A.6, CRM Group Worksheet for TeleSales Agents

= Section A.7, Single-Site Server Group Worksheet

= Section A.8, Middleware Configuration Worksheet

= Section A.9, Server Parameters Worksheet

s Section A.10, Teleset Worksheet

s Section A.11, Media Classification Action Association Worksheet

s Section A.12, CRM Resource Parameters Worksheet
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Oracle Universal Work Queue Administrator Worksheet

A.1 Oracle Universal Work Queue Administrator Worksheet
User Name:
Password:
Responsibilities:
1  System Administrator
@  CRM Resource Manager

0 HRMS Manager, for example US HRMS Manager (if Oracle Human Resources
Management Systems is installed)

0 CRM Task Manager (to test application work in Oracle Universal Work Queue
for application work)

A.2 Employee Worksheet
Last:
Gender:
Type: Employee
Employee (Number):

A.3 Employee User Account Worksheet

User Name:
Password:
Person (Employee):
Responsibilities:
d  Preferences (to access personal profile options for Oracle Universal Work
Queue)
Customer Support
TeleSales Agent
Collections Agent

Senior Collections Agent

U0 dod

Custom (specify):
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Oracle Universal Work Queue Profile Options Worksheet

A.4 Oracle Universal Work Queue Profile Options Worksheet

Profile Option Value

IEU: Blending Style d  Not Blended
3  Full Forced Blended
d  Full Optional Blended

IEU: Desktop: Network: Proxy Port

IEU: Desktop: Network: Proxy Server

IEU: Desktop: Network: Use Proxy No

Yes

IEU: Desktop: Trace Level None

Error
Warning
Informational
Debug

All

IEU: Desktop: UI: Refresh Style Automatic
Login Only

Manual

IEU: Desktop: UI: Show All Nodes No

Yes

o 0000|0000 0 0|0 O
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Oracle Universal Work Queue Profile Options Worksheet

Profile Option Value

IEU: Message: Ul: Refresh Rate 4 Manual
d  Onlogin
4 Onreturn
d 2 minutes
3 minutes
d 5 minutes
10 minutes
d 15 minutes
30 minutes
d 45 minutes
4 1hour
d  2hours
90 minutes

IEU: Message: UL: UWQ Notices d No
d  Yes

IEU: Optional: Phone Extension

IEU: Queue Order: Advanced Outbound Telephony  1-26

IEU: Queue Order: Blended 1-26

IEU: Queue Order: Enterprise Tasks 1-26

IEU: Queue Order: Escalations 1-26

IEU: Queue Order: Forecasts 1-26

IEU: Queue Order: Inbound Email 1-26

IEU: Queue Order: Inbound Telephony 1-26

IEU: Queue Order: Leads 1-26

IEU: Queue Order: Media Nodes 1-26

IEU: Queue Order: Opportunities 1-26

IEU: Queue Order: Outbound Telephony 1-26

IEU: Queue Order: Service Requests 1-26

IEU: Queue Order: Web Collaboration 1-26
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CRM Resource Worksheet

Profile Option Value
IEU: Queue Order: Work List 1-26

[
Z
o

IEU: Queue: Advanced Outbound Telephony

IEU: Queue: Enterprise Tasks

IEU: Queue: Escalations

IEU: Queue: Forecasts

IEU: Queue: Inbound Email

IEU: Queue: Inbound Telephony

IEU: Queue: Leads

IEU: Queue: Opportunities

IEU: Queue: Outbound Telephony

IEU: Queue: Service Requests

IEU: Queue: Work List

IEU: Session History Logging

[ SN Ay A Ay Sy
Z
9

A.5 CRM Resource Worksheet

Name (Employee):

Transaction Number:
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CRM Group Worksheet for TeleSales Agents

Resource Number:

A.6 CRM Group Worksheet for TeleSales Agents

Group Number:
Group Name:

Usages: Sales and Telesales

A.7 Single-Site Server Group Worksheet
Server Group Name:
Location:

Description:

Server Type Server Name Node Assignment

Interaction Queueing and Distribution

Inbound Telephony Server

Routing Server

Telephony Manager

Switch Simulator

Universal Work Queue

A.8 Middleware Configuration Worksheet
Server Group:
Middleware Configuration Name:
IP Address:
Port:
Middleware Type
0 Connectors for CT-Connect

(d Connectors for Cisco ICM
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Middleware Configuration Worksheet

Parameter

Value

PBX Name

PBX Type

Route Point Set 1

Route Point Set 2

Route Point Set 3

Route Point Set 4

Route Point Set 5

CTI Enabler Server IP Address

Middleware Server Info 1

Middleware Server Info 2

Middleware Server Info 3

Middleware Server Info 4

Middleware Server Info 5

Middleware Server Info 6

Outgoing Prefix

International Dialing Prefix

Site Area Code

Site Country Code

Site Internal Number Length

Site Local Number Maximum Length

Site Overlay

IVR Host

IVR Port

IVR Info 1

IVR Info 2

IVR Info 3

IVRI Mode
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Server Parameters Worksheet

Parameter Value

IVRI Abandon Threshold

Domestic Dialing Prefix

Passive Mode

Use Advanced Outbound

Predictive Transfer Flag

Predictive Transfer Wait Time

Predictive Answer Flag

Predictive Answer Wait Time

A.9 Server Parameters Worksheet
Topics include:
= Section A.9.1, Interaction Queueing and Distribution Parameters
= Section A.9.2, Telephony Manager Parameters
= Section A.9.3, Inbound Telephony Server Parameters
= Section A.9.4, Routing Server Parameters
s Section A.9.5, Switch Simulator Parameters

m  Section A.9.6, Universal Work Queue Parameters

A.9.1 Interaction Queueing and Distribution Parameters

Server Name:

Node Assignment:

Parameter Value

DATABASE_LOGGING

DEFAULT_TIMEOUT

IH_JDBC_CONNECTIONS

JDBC_CONNECTIONS

TRACE_LEVEL
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Server Parameters Worksheet

A.9.2 Telephony Manager Parameters

Server Name:
Node Assignment:

No parameters.

A.9.3 Inbound Telephony Server Parameters

Server Name:

Node Assignment:

Parameter Value

DATABASE_LOGGING

TELE_MIDDLEWARE_CONFIG

TRACE_LEVEL

WEB_CALL_PORT

A.9.4 Routing Server Parameters

Server Name:

Node Assignment:

Parameter Value

TRACE_LEVEL

A.9.5 Switch Simulator Parameters

Server Name:

Node Assignment:

Parameter Value

EXTENSION_RANGE_1_BEGIN

EXTENSION_RANGE_1_END

EXTENSION_RANGE_2_BEGIN
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Server Parameters Worksheet

Parameter Value

EXTENSION_RANGE_2_END

EXTENSION_RANGE_3_BEGIN

EXTENSION_RANGE_3_END

ROUTE_POINT_1

ROUTE_POINT_2

ROUTE_POINT_3

TELE_MIDDLEWARE_CONFIG

TRACE_LEVEL

A.9.6 Universal Work Queue Parameters

Server Name:

Node Assignment:

Parameter Value

ENABLE_INTERACTION_BLENDING

ENABLE_LOGGING_AND_ALERTING

LNA_SPILLOVER_FILE

LOAD_CALC_RATE

MAX_ACTIVE_DB_CONNECTIONS

MAX_TIMEOUT_DURATION

MCM_TIMEOUT_DURATION

NETWORK_OBJECT_NUMBER

NETWORK_TRACE

NETWORK_TRACE_FILE

NETWORK_TRACE_LEVEL

NETWORK_USER_NUMBER

RECONN_WAIT_TIME

RUN_AO_IN_SIMULATION
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Teleset Worksheet

Parameter Value
SERVER_PORT

SESSION_CLOSE_DELAY

SESSION_TIMEOUT

TIMEOUT_WAIT_TIME

TRACE_FILE_NAME

TRACE_LEVEL

USE_AOLJ

A.10 Teleset Worksheet

Teleset Name:
Hardware Number:
Teleset Type
Alcatel

Aspect

Cisco

Ericsson
Lucent [Avaya]
Nortel
Rockwell
Siemens

Other [Specify:]

U000 dodJdod

Server Group Name:

Middleware Name:
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Media Classification Action Association Worksheet

A.11 Media Classification Action Association Worksheet

Media Type Classification Media Action

1 Acquired Email 0 Customer Care Media

d  Advanced Outbound Telephony d  Service Requests Media

J  Blended O TeleSales Email

d  Direct Email 0  TeleSales Inbound Telephony
J  Inbound Email O TeleSales Outbound Telephony
d  Inbound Telephony 0  Universal Work Queue Media
d  Outbound Email Diagnostics

d  Outbound Telephony

[ Web Callback

d  Web Classification

1 Outbound Telephony

A.12 CRM Resource Parameters Worksheet
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Transaction Number:
Resource Number:
Interaction Center:

Middleware:

Agent Middleware Parameters:

Parameter Value
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Oracle Universal Work Queue Profile

Options

This topic describes all of the profile options for Oracle Universal Work Queue. The
profile option description includes the following information:

Required: Indicates whether the profile option must be set.

Personal Profile Values: Indicates whether a user can view or update the
profile option. Oracle applications users with Preferences responsibility may
use the Personal Profile Values window to set their own personal profile
options at the user level. Not all profile options are visible to users, and some
profile options, while visible, may not be updated by end users.

System Profile Values: The levels at which a particular profile option can be
set. Oracle Universal Work Queue administrators can set profile options at the
site, application, responsibility, and user levels. Not all profile options have
settings at all levels.

Settings: Available values, a description of the value, and any usage
considerations.

Default Value: The setting for a profile option can be determine by an actual
value or, if no value has been set, by default. Oracle Applications establishes a
value for each option in a user’s profile when the user logs on or changes
responsibility. Depending on the how the profile option is used in the
application, the default may be an actual predefined value or it may be
determined dynamically at runtime.

Profile options include:

Appendix B.1, Obsolete or Reserved Profile Options
Appendix B.2, Blending Profile Options
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Obsolete or Reserved Profile Options

Appendix B.3, Network Profile Options
Appendix B.4, Log Profile Options
Appendix B.5, Desktop Profile Options
Appendix B.6, Notices Profile Options

Appendix B.7, Phone Extension Profile Options

= Appendix B.8, Queue Order Profile Options

= Appendix B.9, Queue Profile Options

B.1 Obsolete or Reserved Profile Options

The following IEU profile options are either reserved for Oracle Support Services,
reserved for future use, or obsolete. The value of these profile option should be No
or null, unless otherwise directed by Oracle.

Profile Option

Status

Description

IEU: Blending: Timeout

Future Use

Use to timeout simple blending on the last
item in list of work item types to be blended.

IEU: Controller: UI: Enable Event Viewer

Support Use

Displays the Status tab in icWork Controller.
The Status tab displays server events, such as
login to a media provider and server status.

IEU: Desktop: UI: Show Filter Panel

Future Use

This enables the filter feature for the All Tasks
node for the IEU: Queue: Tasks node. When
activated, this allows filtering the task
summary lines based on task assignment
ownership, or both.

IEU: Desktop: Ul: Show Tasks Detail Panel

Obsolete

IEU: Media Email

Obsolete

This profile option was used to force the
Oracle eMail Center desktop to launch upon
login to Oracle Universal Work Queue - even
when the Inbound Email node is not enabled

Email client cannot be launched from UWQ

IEU: Media: Telephony

Obsolete

This profile options was used to force the soft
phone to launch upon login to Oracle
Universal Work Queue -- even when
Outbound Telephony node is not enabled.

Soft phone automatically activated if use is
enable for telephony.
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Blending Profile Options

Profile Option Status Description
IEU: Non-Media: Navigate Obsolete This profile option was used to open a
separate application window for each
application work item selected form the
Oracle Universal Work Queue desktop.
IEU: Queue Order: Defects Future Use These profile options will be used to display a
[EU: Queue: Defects D'efects node in the Universal Work Queue
window.
IEU: Queue Order: Enhancements Future Use These profile options will be used to display a
Enhancements node in the Universal Work
IEU: Queue: Enhancements .
Queue window.
IEU: Queue Order: My Tasks Obsolete These profile options display agent owned
IEU: Queue: My Tasks tasks in the Universal Work Queue window.
IEU: Queue Order: Tasks Obsolete These profile options display tasks owned by
. . or assigned to the agent, or to a team or group
IEU: Queue: Tasks to which the agent belongs in the Universal
Work Queue window.
IEU: Queue Order: Web Collaboration Future Use These profile options will be used to display a
: ) . Web Collaboration node in the Universal
IEU: Queue: Web Collaboration .
Work Queue window.
IEU: Queue Order: Work List Future Use These profile options will be used to display a
IEU: Queue: Work List Work List node in the Universal Work Queue
window.
Items published to the Work list node are
dependent on integrated applications
support.
IEU: Queue Order: My Work Removed The My Work node and all its profile options

are obsolete. My Work is replaced with Work
List.

B.2 Blending Profile Options

Topics include:

= Appendix B.2.1, IEU: Blending Style

Oracle Universal Work Queue Profile Options B-3



Blending Profile Options

B.2.1 |IEU: Blending Style

Note: This profile option applies to media work only.

Use this profile option to enable media work blending for Oracle Universal Work
Queue. When media work blending is enabled for Oracle Universal Work Queue,
the Media node is replaced with a Blended node.

The IEU: Blending Style profile option now has five options in the drop down list of
values. The old "Forced Blended" value has been renamed "Full Forced Blended."
The "Not Blended" value remains unchanged. The only other value that has
relevance is "Full Optional Blended." If this value is selected the agent will be
allowed to select media work from either the Blended node or individual media
nodes.

Oracle Interaction Blending must be installed and configured. Oracle Interaction
Blending dynamically moves agents between queues and media types based on the
service levels for the interaction center. For information about implementing Oracle
Interaction Blending, see Oracle Interaction Blending Implementation Guide.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

s Full Forced Blended

B-4 Oracle Universal Work Queue Implementation Guide



Network Profile Options

= Not Blended

= Full Optional Blended

= Simple Forced Blended

= Simple Optional Blended

Default Value
Not Blended

B.3 Network Profile Options
Topics include:
= Appendix B.3.1, IEU: Desktop: Network: Proxy Port
= Appendix B.3.2, IEU: Desktop: Network: Proxy Server
= Appendix B.3.3, IEU: Desktop: Network: Use Proxy

B.3.1 IEU: Desktop: Network: Proxy Port

Note: This profile option applies to media work only.

The Oracle Universal Work Queue desktop bean communicates with the Oracle
Universal Work Queue server over a proprietary interface that supports HTTP or
Sockets. If there is no firewall between the Oracle Universal Work Queue desktop
and the Oracle Universal Work Queue server, then the proxy settings can be
obtained from the Oracle Universal Work Queue server. If there is a firewall
between the Oracle Universal Work Queue desktop and the Oracle Universal Work
Queue server, then you must specify the proxy settings.

Use this profile option to specify the proxy port.

Required
No

Personal Profile Values

View? Yes
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Network Profile Options

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Consult your network administrator for the appropriate proxy settings.

Default Value
Not applicable.

B.3.2 IEU: Desktop: Network: Proxy Server

Note: This profile option applies to media work only.

The Oracle Universal Work Queue desktop bean communicates with the Oracle
Universal Work Queue server over a proprietary interface that supports HTTP or
Sockets. If there is no firewall between the Oracle Universal Work Queue desktop
and the Oracle Universal Work Queue server, then the proxy settings can be
obtained from the Oracle Universal Work Queue server. If there is a firewall
between the Oracle Universal Work Queue desktop and the Oracle Universal Work
Queue server, then you must specify the proxy settings.

Use this profile option to specify the proxy port.

Required
No

Personal Profile Values

View? Yes
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Network Profile Options

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Consult your network administrator for the appropriate proxy settings.

Default Value
Not applicable.

B.3.3 IEU: Desktop: Network: Use Proxy

Note: This profile option applies to media work only.

The Oracle Universal Work Queue desktop bean communicates with the Oracle
Universal Work Queue server over a proprietary interface that supports HTTP or
Sockets. If there is no firewall between the Oracle Universal Work Queue desktop
and the Oracle Universal Work Queue server, then the proxy settings can be
obtained from the Oracle Universal Work Queue server. If there is a firewall
between the Oracle Universal Work Queue desktop and the Oracle Universal Work
Queue server, then you must specify the proxy settings.

Use this profile option to indicate whether the proxy settings for the Oracle
Universal Work Queue server will be determined from the server or specified in the
Oracle Universal Work Queue system profile options.

Required
No
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Log Profile Options

Personal Profile Values

View? Yes

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The proxy settings for the Oracle Universal Work Queue server will

be determined from the server.

Yes The proxy settings for the Oracle Universal Work Queue server are
specified in the Oracle Universal Work Queue system profile options.

Default Value
No

B.4 Log Profile Options

Topics include:

= Appendix B.4.1, IEU: Desktop: Trace Level

B.4.1 IEU: Desktop: Trace Level

Controls the output to the Java console.

Required
No
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Desktop Profile Options

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes

User? Yes

Settings

None

Error
Warning
Informational
Debug

All

Default Value
No

B.5 Desktop Profile Options

Topics include:
= Appendix B.5.1, IEU: Desktop: Ul: Refresh Style
= Appendix B.5.2, IEU: Desktop: UI: Show All Nodes
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Desktop Profile Options

B.5.1 IEU: Desktop: Ul: Refresh Style

Note: This profile option applies to application and media work.

Use this profile option to specify the strategy for refreshing work item counts in the
Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

Automatic The Oracle Universal Work Queue desktop refreshes:

= upon login to the Oracle Universal Work Queue desktop
= after each delivery of media work

Automatic refresh may affect the performance of the Oracle
Universal Work Queue server. After delivery of the work item, the
Oracle Universal Work Queue desktop can not be used until the
count is updated.

Login Only The Oracle Universal Work Queue desktop is refreshed once upon
login. After login, the Oracle Universal Work Queue desktop
must be refreshed manually.
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Notices Profile Options

Manual The user must manually refresh the Oracle Universal Work Queue
desktop. The Oracle Universal Work Queue desktop is not
automatically refreshed upon login.

Default Value
Manual

B.5.2 IEU: Desktop: Ul: Show All Nodes

Note: This profile option applies to application and media work.

Use this profile option to display subnodes that have a zero count in the Oracle
Universal Work Queue desktop.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes

B.6 Notices Profile Options

Topics include:
= Appendix B.6.2, IEU: Message: Ul: Refresh Rate
= Appendix B.6.1, IEU: Message: UL: UWQ Notices
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Notices Profile Options

B.6.1 IEU: Message: Ul: UWQ Notices

This will enable the user for notices, causing the Notices tab to display on the
icWork Controller.

Note: UWQ notices also require the IEU: Message: UI: Refresh
Rate profile option to be set. See B.6.2.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

No

Yes

Default Value
Yes

B.6.2 IEU: Message: Ul: Refresh Rate

Use this profile option to set the time increments to check for new notices. UWQ
notices must be enabled for this refresh rate to function.
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Notices Profile Options

Note:

This profile option must be administered to refresh notices

at an appropriate refresh rate. Otherwise, agents will not be aware
of notices in a timely fashion. To determine the appropriate refresh
rate, refer to your interaction center systems administrator.

Note:

This profile option applies to application and media work.

Use this profile option to display subnodes that have a zero count in the Oracle

Universal Work Queue desktop.

Required
No

Personal Profile Values

View?

Update?

No
No

System Profile Values

Site?
Application?
Responsibility?

User?

Yes
Yes
Yes
Yes

Settings

10 minutes
2 hours

15 minutes
2 minutes

3 minutes
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Phone Extension Profile Options

30 minutes
45 minutes
5 minutes
1 hour

90 minutes
Manual
On login

On return

Default Value
Yes

B.7 Phone Extension Profile Options
Topics include:

= Appendix B.7.1, IEU: Optional: Phone Extension

B.7.1 IEU: Optional: Phone Extension

Note: This profile option applies to media work only.

Use this profile option to specify the extension of the physical phone of the agent.
For an agent enabled for telephony, Oracle Universal Work Queue bypasses the
Phone Extension window upon login and passes the value of this profile option
value to Oracle Telephony Manager.

Required
No

Personal Profile Values

View? No

Update? No
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Queue Order Profile Options

System Profile Values

Site? No
Application? No
Responsibility? No
User? Yes
Settings

The extension of the physical phone of the agent.

Default Value
Not applicable

B.8 Queue Order Profile Options
Topics include:
= Appendix B.8.1, IEU: Queue Order: Advanced Outbound Telephony
s Appendix B.8.2, IEU: Queue Order: Blended
= Appendix B.8.3, IEU: Queue Order: Enterprise Tasks
= Appendix B.8.4, IEU: Queue Order: Escalations
= Appendix B.8.5, IEU: Queue Order: Forecasts
= Appendix B.8.6, IEU: Queue Order: Inbound Email
= Appendix B.8.7, IEU: Queue Order: Inbound Telephony
= Appendix B.8.8, IEU: Queue Order: Leads
= Appendix B.8.9, IEU: Queue Order: Media Nodes
= Appendix B.8.10, IEU: Queue Order: Opportunities
= Appendix B.8.11, IEU: Queue Order: Outbound Telephony
s Appendix B.8.12, IEU: Queue Order: Service Requests
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Queue Order Profile Options

B.8.1 IEU: Queue Order: Advanced Outbound Telephony

Use this profile option to specify the order of the Advanced Outbound node in the
list of nodes on the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.2 IEU: Queue Order: Blended

Use this profile option to specify the order of the Blended node in the list of nodes
on the Oracle Universal Work Queue desktop.

Required
No
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Queue Order Profile Options

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.3 IEU: Queue Order: Enterprise Tasks

Use this profile option to specify the order of the Tasks node in the list of nodes on
the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
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Queue Order Profile Options

Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.4 IEU: Queue Order: Escalations

Use this profile option to specify the order of the Escalations node in the list of
nodes on the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.
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Queue Order Profile Options

Default Value
Not applicable

B.8.5 IEU: Queue Order: Forecasts

Use this profile option to specify the order of the Forecasts node in the list of nodes
on the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.6 IEU: Queue Order: Inbound Email

Use this profile option to specify the order of the Inbound Email node in the list of
nodes on the Oracle Universal Work Queue desktop.
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Queue Order Profile Options

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.7 IEU: Queue Order: Inbound Telephony

Use this profile option to specify the order of the Inbound Telephony node in the
list of nodes on the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? Yes

Update? Yes
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System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.8 IEU: Queue Order: Leads

Use this profile option to specify the order of the Leads node in the list of nodes on
the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View?

Update?

Yes
Yes

System Profile Values

Site?
Application?
Responsibility?

User?

Yes
Yes
Yes
Yes
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Settings
Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.9 IEU: Queue Order: Media Nodes

Use this profile option to specify the order of the Media node in the list of nodes on
the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable
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B.8.10 IEU: Queue Order: Opportunities

Use this profile option to specify the order of the Opportunities node in the list of
nodes on the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View?

Update?

Yes
Yes

System Profile Values

Site?
Application?
Responsibility?

User?

Yes
Yes
Yes
Yes

Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.11 IEU: Queue Order: Outbound Telephony

Use this profile option to specify the order of the Outbound Telephony node in the
list of nodes on the Oracle Universal Work Queue desktop.

Required
No
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Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.8.12 IEU: Queue Order: Service Requests

Use this profile option to specify the order of the Service Requests node in the list of
nodes on the Oracle Universal Work Queue desktop.

Required
No

Personal Profile Values

View? Yes

Update? Yes

System Profile Values

Site? Yes
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Application? Yes
Responsibility? Yes
User? Yes
Settings

Choose from numbers 1 through 26. Nodes are displayed in ascending order in the
Oracle Universal Work Queue desktop.

Default Value
Not applicable

B.9 Queue Profile Options

Topics include:

Appendix B.9.1, IEU: Queue
Appendix B.9.2, IEU: Queue
Appendix B.9.3, IEU: Queue
Appendix B.9.4, IEU: Queue
Appendix B.9.5, IEU: Queue
Appendix B.9.6, IEU: Queue
Appendix B.9.7, IEU: Queue
Appendix B.9.8, IEU: Queue
Appendix B.9.9, IEU: Queue

: Advanced Outbound
: Enterprise Tasks

: Escalations

: Forecasts

: Inbound Email

: Inbound Telephony

: Leads

: Opportunities

: Outbound Telephony

Appendix B.9.10, IEU: Queue: Service Requests

B.9.1 IEU: Queue: Advanced Outbound

Note: This profile option applies to media work only.

Use this profile option to display the Advanced Outbound node in the Oracle
Universal Work Queue desktop.
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Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Advanced Outbound Telephony node is not displayed in the

Oracle Universal Work Queue desktop.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.2 IEU: Queue: Enterprise Tasks

Note: This profile option applies to application work only.

Use this profile option to display the Tasks node in the Oracle Universal Work
Queue desktop.

Required
No
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Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Enterprise Tasks node is not displayed in the Oracle Universal
Work Queue desktop.

Yes The Enterprise Tasks node is displayed in the Oracle Universal Work

Queue desktop. If the user is configured as a Oracle Universal Work
Queue agent and has the appropriate responsibilities, then the user
will be able to access work from the Enhancements node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.3 IEU: Queue: Escalations

Note: This profile option applies to application work only.

Use this profile option to display the Escalations node in the Oracle Universal Work
Queue desktop.

Required
No
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Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Escalations node is not displayed in the Oracle Universal Work
Queue desktop.

Yes The Escalations node is displayed in the Oracle Universal Work

Queue desktop. If the user is configured as a Oracle Universal Work
Queue agent and has the appropriate responsibilities, then the user
will be able to access work from the Enhancements node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.4 IEU: Queue: Forecasts

Note: This profile option applies to application work only.

Use this profile option to display the Forecasts node in the Oracle Universal Work
Queue desktop.

Required
No
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Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Forecasts node is not displayed in the Oracle Universal Work
Queue desktop.

Yes The Forecasts node is displayed in the Oracle Universal Work Queue

desktop. If the user is configured as a Oracle Universal Work Queue
agent and has the appropriate responsibilities, then the user will be
able to access work from the Forecasts node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.5 IEU: Queue: Inbound Email

Note: This profile option applies to media work only.

Use this profile option to display the Inbound Email node in the Oracle Universal
Work Queue desktop. Inbound e-mail is created when e-mail is sent to the user’s
e-mail account.

Required
No
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Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Inbound Email node is not displayed in the Oracle Universal
Work Queue desktop.

Yes The Inbound Email node is displayed in the Oracle Universal Work

Queue desktop. If the user is configured as a Oracle Universal Work
Queue agent and has the appropriate responsibilities, then the user
will be able to access work from the Inbound Email node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.6 IEU: Queue: Inbound Telephony

Note: This profile option applies to media work only.

Use this profile option to display the Inbound Telephony node in the Oracle
Universal Work Queue desktop. Inbound telephony work is created when Oracle
Telephony Manager routes an inbound call to an agent.

Required
No

B-30 Oracle Universal Work Queue Implementation Guide



Queue Profile Options

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Inbound Telephony node is not displayed in the Oracle

Universal Work Queue desktop.

Yes The Inbound Telephony node is displayed in the Oracle Universal
Work Queue desktop. If the user is configured as a Oracle Universal
Work Queue agent and has the appropriate responsibilities, then the
user will be able to access work from the Inbound Telephony node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.7 IEU: Queue: Leads

Note: This profile option applies to application work only.

Use this profile option to display the Leads node in the Oracle Universal Work
Queue desktop. Leads are created in Oracle TeleSales.

Required
No
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Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Leads node is not displayed in the Oracle Universal Work Queue
desktop.

Yes The Leads node is displayed in the Oracle Universal Work Queue

desktop. If the user is configured as a Oracle Universal Work Queue
agent and has the appropriate responsibilities, then the user will be
able to access work from the Leads node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.8 IEU: Queue: Opportunities

Note: This profile option applies to application work only.

Use this profile option to display the Opportunities node in the Oracle Universal
Work Queue desktop. Opportunities are created in Oracle TeleSales.

Required
No
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Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Opportunities node is not displayed in the Oracle Universal
Work Queue desktop.

Yes The Opportunities node is displayed in the Oracle Universal Work

Queue desktop. If the user is configured as a Oracle Universal Work
Queue agent and has the appropriate responsibilities, then the user
will be able to access work from the Enhancement node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.

B.9.9 IEU: Queue: Outbound Telephony

Note: This profile option applies to media work only.

This profile option is actually for pre-11.5.6 Campaign Plus and Predictive sites and
remains in Oracle Applications for compatibility with earlier releases of Oracle
Advanced Outbound.

Use this profile option to display the Outbound Telephony node in the Oracle
Universal Work Queue desktop. Outbound telephony work is created when Oracle
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Advanced Outbound (Oracle Campaign Plus and Predictive) assigns an outbound
call to an agent.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Outbound Telephony node is not displayed in the Oracle

Universal Work Queue desktop.

Yes The Outbound Telephony node is displayed in the Oracle Universal
Work Queue desktop. If the user is configured as a Oracle Universal
Work Queue agent and has the appropriate responsibilities, then the
user will be able to access work from the Outbound Telephony node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.
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B.9.10 IEU: Queue: Service Requests

Note: This profile option applies to application work only.

Use this profile option to display the Service Requests node in the Oracle Universal
Work Queue desktop. Service requests are created in Oracle TeleService.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes

Application? Yes

Responsibility? Yes

User? Yes

Settings

No The Service Requests node is not displayed in the Oracle Universal
Work Queue desktop.

Yes The Service Requests node is displayed in the Oracle Universal Work

Queue desktop. If the user is configured as a Oracle Universal Work
Queue agent and has the appropriate responsibilities, then the user
will be able to access work from the Enhancement node.

Default Value

Yes, if the application user responsibilities and CRM resource configuration for the
agent provide access to the work item and/or business application.
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B.10 Session Logs
Topics include:

= Section B.10.1, IEU: Session History Logging

B.10.1 IEU: Session History Logging

There is an Oracle Universal Work Queue session history table for ICI reporting.

This activates UWQ Session Information. Session Information extends the
capabilities of Interaction Center Intelligence to support agent productivity reports.
Session information tracks session login time, session logout time, and session exit
reason. It also tracks agent break request time, agent break reason, and the end
break time when agents resume work following a break. In addition, session
information records media item request, delivery, and completion times; worklist
request delivery and completion times; and work item request and delivery times.

Activating session information enables icWork and activates the Break control.

Required
No

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? Yes
Responsibility? Yes
User? Yes
Settings

No
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Yes

Default Value
No

B.11 Non-UWQ Profile Options

Topics include:

= Section B.11.1, Apps Servlet Agent

B.11.1 Apps Servlet Agent

This profile option is not owned by UWQ. This setting contains the URL to connect
to the Servlet Zone of the Apache Web server, which is required for UWQ agents to
use the icWork Controller. Set this profile option at the site level to the base URL for
the Web server used for the JTF login page, including the port number.

Syntax: http://<machine name.domain>:<Apache Web server
port>/<servlet zones.

Example:http://server0l.yourcompany.com:7777/oa_servlets

Required
Yes

Personal Profile Values

View? No

Update? No

System Profile Values

Site? Yes
Application? No
Responsibility? No
User? No
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Settings

No
Yes

Default Value
No
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Oracle Universal Work Queue Server
Parameters

The following table lists and defines the parameter names for which values can be
set for Oracle Universal Work Queue servers. The following Oracle Universal Work
Queue server parameters are loaded from the database. Database parameters
override any command line parameters passed to the Oracle Universal Work Queue
server. These parameters are strings when stored in the database.

C.1 ENABLE_INTERACTION_BLENDING

Deprecated (this is set and used based on data found in the database.)

Type Unit Max Value Min Value Default

boolean N/A N/A N/A false

C.2 ENABLE_LOGGING_AND_ALERTING

Enables / Disables the logging and alerting subsystem.

Type Unit Max Value Min Value Default

boolean N/A N/A N/A false

C.3 LNA_SPILLOVER_FILE

Name of the Logging and Alerting spillover file. The file generated by Logging And
Alerting subsystem when the database connection goes down.
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LOAD_CALC_RATE

Type Unit Max Value Min Value Default
String N/A N/A N/A spillover/uwq
spillover

C.4 LOAD_CALC_RATE

The rate at which the load factors on the UWQ Server are calculated.

Type Unit Max Value Min Value Default

int seconds 65,536 0 20

C.5 MAX_ACTIVE_DB_CONNECTIONS

Deprecated (this is set in the DBC file)

Type Unit Max Value Min Value Default

int N/A 65,536 0 3

C.6 MAX_TIMEOUT_DURATION

The time after which a transaction times out in the UWQ Server. This is used mainly
for timing out remote transactions within the UWQ Server. This time out affects any
remote transactions done from the client

Type Unit Max Value Min Value Default

int seconds 65,536 0 40

C.7 MCM_TIMEOUT_DURATION

Time after which OTM/MCM transactions time out.

Note: If the MCM_TIMEOUT_DURATION value is left unset, the default value is
the value assigned to the MAX_TIMEOUT_DURATION parameter.

Type Unit Max Value Min Value Default

int seconds 65,536 0

C-2 Oracle Universal Work Queue Implementation Guide



NETWORK_TRACE_LEVEL

C.8 NETWORK_OBJECT_NUMBER

The default number of sessions the Network layer is expected to maintain.

Type Unit Max Value Min Value Default
int N/A 65,536 0 200

C.9 NETWORK_TRACE

Flag indicating if Network Traces should be generated.

Type Unit Max Value Min Value Default
boolean N/A N/A N/A false

C.10 NETWORK_TRACE_FILE

The network trace file name.

Type Unit Max Value Min Value Default
String N/A N/A N/A UWQNetwork_
logs

C.11 NETWORK_TRACE_LEVEL

Trace level for the network logs

= NONE = 0x000; Turns off all events
= DETAIL =0x001; Detailed transactions useful for performance monitor
= INFO = 0x002; Informational e.g., network connection regained

= MINOR =0x004; Limited failures e.g., method call failed
= CRITICAL = 0x008; Catastrophic failure e.g., lost network connection

Type Unit Max Value Min Value Default
int N/A OxFFF 0 0
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C.12 NETWORK_USER_NUMBER

The default number of remote objects the Network Layer is expected to maintain.

Type Unit Max Value Min Value Default

int N/A 65,536 0 200

C.13 RECONN_WAIT_TIME

Time between tries to reconnect to remote servers/database etc.

Type Unit Max Value Min Value Default

int seconds 65,536 0 60

C.14 SERVER_PORT

Port the UWQ Server is registered on.

Refer to platform specific documentation regarding port usage. The UWQ Server
utilizes HTTP communications for access by web-based agents. If the server is to be
accessed in this way;, it is recommended that the default port 80 be used since many
HTTP proxies won't forward HTTP requests to ports other than 80. Obviously, the
UWQ Server won't be able to run on the same machine as a web server if port 80 is
selected.

On UNIX machines any port below 1024 cannot be accessed by a process which is
non root owned.

Type Unit Max Value Min Value Default

int N/A 65,536 0 80

C.15 SESSION_CLOSE_DELAY

Time period (in seconds) to delay session removal after a session has been
disconnected due to Client or Network failures. This prevents sessions from having
to be completely reconstructed due to a brief network outage.
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Type Unit Max Value Min Value Default

int seconds 65,536 0 180

C.16 SESSION_TIMEOUT

Default Session inactivity timeout period (in minutes). This may be overridden
during client-side session creation.

Type Unit Max Value Min Value Default

int minutes 65,536 0 1

C.17 TIMEOUT_WAIT_TIME

Time after which retries are done in server threads. This applies to all server threads
including reconnection threads.

Type Unit Max Value Min Value Default

int seconds 65,536 0 10

C.18 TRACE_FILE_NAME

Name of the UWQ Server Trace File

Type Unit Max Value Min Value Default
String N/A N/A N/A UWQServer_
logs

C.19 TRACE_LEVEL

The Trace level for writing traces to the Server Trace file
= LEVEL_ERROR = 0x0001;

= LEVEL_WARN = 0x0003;

= LEVEL_INFO = 0x0007;

= LEVEL_TRACE = 0x000F;
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» LEVEL ALL = O0xFFFF;

Type Unit Max Value Min Value Default

int N/A OxFFFF 0 0

C.20 USE_AOLJ

Indicates if AOL/] is to be used to connect to the database or the connection has to
be obtained using regular JDBC.

Type Unit Max Value Min Value Default

boolean N/A N/A N/A true
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Oracle Universal Work Queue Command

Line Parameters

Command line parameters are not typically used in implementing Oracle Universal
Work Queue because these settings are set as a result of configuring your
interaction center through Oracle Interaction Center Server Manager (ICSM). These
command line parameters may be required, in coordination with Oracle Support
Services, to debug potential problems (for example, if ICSM is down). For this
reason, the UWQ command line parameters are documented below.

The following table lists and defines the parameters that can be set using the Oracle
Universal Work Queue server command line:

java oracle.apps.ieu.server.UWQServerLauncher [option <value>] [...]
Command line parameters (other than the required parameters and -console) may

be overridden by the database parameter for the Oracle Universal Work Queue
server.

D.1 -console

D.2 - port

Enables display of the UWQ Server GUI control panel and console trace.

Value Min Length Max Length Required Default
N/A N/A N/A NO disabled

Specifies the Port number the server will listen on.
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D.3 - name

D.4 -dbc

Refer to platform specific documentation regarding port usage. The UWQ Server
utilizes HTTP communications for access by web-based agents. If the server is to be
accessed in this way, it is recommended that the default port 80 be used since many
HTTP proxies won't forward HTTP requests to ports other than 80. Obviously, the
UWQ Server won't be able to run on the same machine as a web server if port 80 is
selected.

Value Min Length Max Length Required Default

Number 1 5 NO 80

The name the UWQ Server will utilize to query itself in the database.

The UWQ Server name must be unique among all UWQ Servers across the
deployment. If the UWQ Server detects another instance with the same name
already running it will wait for the other instance to shutdown before completing
initialization.

Value Min Length Max Length Required Default

String 1 6,6555 YES N/A

The file name prepended by the file path where the . dbc file is located.

Refer to the Universal Installer documentation regarding creation/format of the
.dbc file.

Value Min Length Max Length! Required Default

String 1 255 YES N/A

! Refer to platform specific documentation regarding maximum allowable file path/name size.

D.5 -trace file_name

The name of the trace file containing debug information.
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Value Min Length Max Length' Required Default

String 1 255 NO null (Output will
only go to
stdout.)

! Refer to platform specific documentation regarding maximum allowable file path/name size.

D.6 - max_num_threads

Defines the maximum number of threads which may be allocated to the UWQ
Server’s internal thread pool.

The internal UWQ Server Thread Pool does not control threads allocated for remote
communications. Thus, this does not indicate the maximum number of threads
which will be utilized by the UWQ Server. Also, it is recommended that this not be
set as a command line parameter, as the UWQ Server will season the value in the
database according to levels of demand.

Value Min Length Max Length Required Default
Number 1 10 NO 50

D.7 - min_num_threads

Defines the minimum number of threads which will be allocated to UWQ Server’s
internal thread pool.

The internal UWQ Server Thread Pool does not control threads allocated for remote
communications. Thus, this by no means indicates the maximum number of threads
which will be utilized by the UWQ Server. Also, it is recommended that this not be
set as a command line parameter as the UWQ Server will season the value in the
database according to levels of demand.

Value Min Length Max Length Required Default
Number 1 10 NO 5

D.8 -trace_level_debug

Turns on detailed tracing of all server activity.
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Only one trace level parameter may be specified. If multiple trace level parameters
are specified the parameter appearing first will be enforced and the others
following will be ignored. WARNING!: The trace that is produced can be very
verbose and affect performance.

Value Min Length Max Length Required Default

N/A N/A N/A NO disabled

D.9 -trace level warn

Turns on tracing of all server warnings and errors.

Only one trace level parameter may be specified. If multiple trace level parameters
are specified the parameter appearing first will be enforced and the others
following will be ignored. WARNING!: The trace that is produced can be very
verbose and affect performance.

Value Min Length Max Length Required Default

N/A N/A N/A NO disabled

D.10 -trace level info

Turns on tracing of all server events, warnings and errors.

Only one trace level parameter may be specified. If multiple trace level parameters
are specified the parameter appearing first will be enforced and the others
following will be ignored. WARNING!: The trace that is produced can be very
verbose and affect performance.

Value Min Length Max Length Required Default

N/A N/A N/A NO disabled

D.11 -trace level_error

Turns on tracing of only server errors.

Only one trace level parameter may be specified. If multiple trace level parameters
are specified the parameter appearing first will be enforced and the others
following will be ignored. WARNING!: The trace that is produced can be very
verbose and affect performance.
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Value Min Length Max Length Required Default
N/A N/A N/A NO disabled

D.12 - command

Turns on display of the UWQ Command Prompt. This allows acceptance of control
commands from the command line e.g., Shutdown

Value Min Length Max Length Required Default
N/A N/A N/A NO disabled
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